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Milli Eğitim Bakanlığı tarafından geliştirilen modüller;

 Talim ve Terbiye Kurulu Başkanlığının 02.06.2006 tarih ve 269 sayılı
Kararı ile onaylanan, Mesleki ve Teknik Eğitim Okul ve Kurumlarında
kademeli olarak yaygınlaştırılan 42 alan ve 192 dala ait çerçeve öğretim
programlarında amaçlanan mesleki yeterlikleri kazandırmaya yönelik
geliştirilmiş öğretim materyalleridir (Ders Notlarıdır).

 Modüller, bireylere mesleki yeterlik kazandırmak ve bireysel öğrenmeye
rehberlik etmek amacıyla öğrenme materyali olarak hazırlanmış,
denenmek ve geliştirilmek üzere Mesleki ve Teknik Eğitim Okul ve
Kurumlarında uygulanmaya başlanmıştır.

 Modüller teknolojik gelişmelere paralel olarak, amaçlanan yeterliği
kazandırmak koşulu ile eğitim öğretim sırasında geliştirilebilir ve
yapılması önerilen değişiklikler Bakanlıkta ilgili birime bildirilir.

 Örgün ve yaygın eğitim kurumları, işletmeler ve kendi kendine mesleki
yeterlik kazanmak isteyen bireyler modüllere internet üzerinden
ulaşılabilirler.

 Basılmış modüller, eğitim kurumlarında öğrencilere ücretsiz olarak dağıtılır.

 Modüller hiçbir şekilde ticari amaçla kullanılamaz ve ücret karşılığında
satılamaz.
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AÇIKLAMALAR

KOD 213GIM188

ALAN Matbaa

DAL/MESLEK Baskı Öncesi Operatörü
MODÜLÜN ADI Dekupe

MODÜLÜN TANIMI
Resmin dekupe yapılması ile ilgili bilgi ve becerilerin
kazandırıldığı öğrenme materyalidir.

SÜRE 40/32+32

ÖN KOŞUL Tarama ve düzeltme modülünü başarmış olmak.

YETERLİK Dekupe yapabilmek.

MODÜLÜN AMACI

Genel Amaç

Gerekli ortam sağlandığında, tekniğine uygun olarak resim
işleme programında dekupe yapabileceksiniz.

Amaçlar
1. Tekniğine uygun olarak Pen (dolmakalem) çizim aracıyla

resmin kenar hatlarını çizerek patika oluşturabileceksiniz.

2. Resmi path (yol, patika) hâline getirebilecek ve dekupe
işleminde kullanılan diğer yöntemleri kullanarak dekupe
yapabileceksiniz.

EĞİTİM ÖĞRETİM
ORTAMLARI VE
DONANIMLARI

Ortam: Masaüstü yayıncılık laboratuarı, atölye, işletme vb.
Donanım: Bilgisayar, tarayıcı, yazıcı, dijital fotoğraf
makinesi, görüntü işleme programı ve projeksiyon cihazı.

ÖLÇME VE
DEĞERLENDİRME

Bu modül içerisinde her öğrenme faaliyetinden sonra çoktan
seçmeli sorular ve uygulamalı sorularla kendi kendinizi
değerlendirebileceksiniz.
Modül sonunda öğretmeniniz tarafından yapılan uygulamalı
sınavla, kazandığınız bilgi ve beceriler değerlendirilecektir.

AÇIKLAMALAR
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GİRİŞ

Sevgili Öğrenci,

Görüntü işleme çalışmalarında sıklıkla yapılan işlemlerden bir tanesi de dekupedir.
Dekupe, kısaca resmin belli bir bölgesini diğer bölgelerden ayırmaktır. Dekupe yapılarak
resim bileşeninin zemini değiştirilebilir veya resmin sadece belli bir bölgesi dışında kalan
diğer bölgeler silinebilir.

Çalışılan resme göre veya dekupesi yapılacak resim bileşenin şekline göre dekupe
yöntemi değişebilmektedir. Kullanılan yöntem ne olursa olsun dekupe çok dikkat ve titizlik
gerektiren bir iştir.

Bu modülde dekupe işlemini yapmak için gerekli olan bilgiler ve uygulama
faaliyetleri verilmiştir. Dikkatli ve düzenli çalışmanız sizi başarıya ulaştıracaktır.

Resim işleme çalışmalarında sıklıkla karşılaşılan dekupe işlemini en iyi şekilde
öğrenip yapacağınıza inanıyor ve başarılar diliyoruz.

GİRİŞ



2



3

ÖĞRENME FAALİYETİ–1

Bu faaliyet ile gerekli ortam sağlandığında, görüntü işleme programında, tekniğine
uygun olarak pen (dolmakalem) çizim aracıyla resmin kenar hatlarını çizerek patika
oluşturabileceksiniz.

Basılı ve elektronik yayınları inceleyiniz. Özellikle masaüstü yayıncılık dergilerinden
dekupe örneklerine ve ayrıntılı bilgilere ulaşabilirsiniz. Profesyonel fotoğrafçıların dekupe
işlemini nasıl yaptığını araştırınız. Çevrenizde bulunan bu konuda uzman kişilerden bilgi
alınız. Topladığınız bilgileri arkadaşlarınızla paylaşınız.

1. DEKUPE İŞLEMİNDE KULLANILAN
ARAÇLAR

Resimler üzerinde çalışırken resimlerin belli bir bölgesini başka bir resme aktarmak,
iki veya daha fazla resmin belli bölgelerini alıp yeni bir resimde kullanmak veya resmin belli
bölgesini temizlemek gerekebilir. Örneğin aşağıdaki kuşun sadece kendi görüntüsü
kullanılmak isteniyor. Yani arka fon temizlenmek isteniyor. Bu durumda yapılması gereken,
kuşu kenar hatlarından seçip resmin kalan diğer bölgesini silmektir. İşte yapılan bu işlem
dekupe işlemidir.

Kısaca, fotoğraf işleme çalışmalarında fotoğrafın belli bir bölgesinin kalan
bölgelerden ayırma veya temizleme işlemleri dekupe olarak adlandırılır.

Resim 1.1: Orijinal Resim 1.2: Dekupe edilmiş resim

ÖĞRENME FAALİYETİ– 1

AMAÇ

ARAŞTIRMA
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Dekupe işlemi üç aşamadan oluşur:

1. Seçim yapmak
2. Seçimi path paletine kaydetmek
3. Seçim dışında kalan diğer bölgeleri temizlemek

Dekupe işleminin özü seçimdir. Seçimin iyi yapılması ve bu seçimde doğru aracın
kullanılması işin neticesini müspet yönde etkileyecektir. Seçim için seçim araçları
kullanıldığı gibi dekupede işleminde seçim aracı olarak pen (dolmakalem) aracı da kullanılır.

Diğer seçim araçları belirli bir piksel grubunu bir alan içine hapsedip seçilir. Seçili
alanın sınırlarına bir imleç ile müdahale edilemez. Ancak bir diğer alan daha seçerek bir
öncekine ekleme yapılabilir. Pen aracı, vektörel bir seçme aracıdır. Bir başka deyişle,
vektörel çizgilerle oluşturulmuş sınır tanıma veya seçme aracıdır. Bu araç sayesinde
seçilecek piksel grubunun çevresinde bir hat çizip, bunun izlediği patikanın biçimi istenildiği
gibi ve istenildiği zaman değiştirilebilir.

Resim 1.3: Pen araçları

Dekupesi yapılacak veya seçilecek resim bileşeninin kenar hatlarından pen aracı ile
geçilir. Pen aracı ile yapılan çizimlere path (patika) adı verilir. Patikalar otomatik olarak path
paletine kaydedilir.

Patikanın kenar hatları vektöreldir. Patika hattının vektörel olması, seçili alanın
sınırında yüksek çözünürlük, yani keskin çizgiler oluşmasını sağlayacaktır. Böylece hızlı
seçim araçlarıyla yapılabilen çok daha hassas bir seçim seti oluşturulabilir.

Patikalar başka dosyalara çizgi amaçlı kullanmak üzere ihraç edilebilir. Patikalar,
hassas seçimler yapmak, çizgi olarak kullanmak, kenar hatları vektörel hâle getirmek gibi
farklı amaçlar için kullanılabilmektedir. Örneğin piksel bazlı çizgi çizmek zorken, path ile
vektörel olarak çizilebilir, yani patika çizgiye de çevirilebilir. Patikaların hangi amaçla
kullanılacağı kullanıcıya bağlıdır. Patikaların kullanımı öğrenildikten sonra yeni kullanım
alanları da bulunabilir.
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1.1. Patika Araçları ve Seçenekleri

1.1.1. Pen (Dolmakalem) Aracı

Patika çizimlerinde çoğunlukla pen (dolmakalem) aracının kullanıldığına
yukarıda değinmiştik. Pen aracı araç kutusunda bulunur ve “P” kısayolu kullanılarak
seçilebilir. Aracın simgesi yukarıda görüldüğü gibi dolmakalem ucuna benzer.

Dolmakalem, ekranda ayrı ayrı tıklanmış iki noktanın arasına patika çizer. Çizginin
başlangıç ve bitiş noktaları, daha sonra patikanın biçimini değiştirebilmek için tanımlanmış
kontrol noktaları olacaktır ve adları resim işleme programında Anchor Point (Düğüm
Noktası) olarak geçer.

Resim 1.4: Patikanın yapısı

Patika çoğunlukla kullanıldığı gibi kapalı bir çokgen olmak zorunda değildir. İki ucu
doğrusal patikalarda oluşturulabilir. Çizilen patikalar ekranda görünse de asla baskıda
çıkmaz, onlar sanaldır.

Patika çizmek için dolmakalem aracı alınır ve araç seçenekleri çubuğundan
dolmakalem aracı işaretlenir. Dolmakalem aracı, kalemle çizer gibi tıklanarak sürüklenmez.
Bu araç noktalarla çalışır. Resim üzerinde istenilen bölgeye tıklanır. Tıklanılan yerde minik
bir kare belirecektir. Sonra bir diğer noktaya tıklandığında tıklanılan bu iki nokta arasında
patika elde edilir. İstenilen patika elde edilinceye kadar yeni noktalar eklenmeye devam
edilir.

Noktalar eklenirken shift tuşuna basılı tutularak düz çizgiler elde edilir. Dolmakalem
aracı ile yeni nokta elde etmek için tıklandığında işaretleme tuşuna basılı tutarak fare hafif
hareket ettirilir. Bu şekilde noktadan yanlara doğru açılan tutamaklar belirir. Tutamaklar
çıktığında patika çizgisinin eğriselleştiğine dikkat ediniz. Tutamaklar tutularak patika
çizgisine fareyi hareket ettirerek şekil verilebilir. Tutamak hangi yönde hareket ettirilirse
patika eğrisi onun tersi yönünde harekete geçip biçim değiştirecektir. Bu işlemin çizim
bittikten sonra yapılması daha sağlıklı olur.

Düğüm Noktası

Düğüm Noktası

Seçili Düğüm Noktası

Yönlendirme çizgisi
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Patikanın başlangıç noktasının üzerine gelindiğinde, program çokgeni kapatıp
kapatmayacağımızı hatırlatmak için dolmakalemin altında minik bir daire simgesi
belirecektir. Başlangıç noktasının üzerine tıklandığında çokgen kapanacaktır. Patikaların
çizim amacı genelde seçim yapmaktır. Seçim yapılabilmesi için de patikaların kapalı olması
gerekmektedir.

Resim 1.5: Kenar hatlarına patika çizilen resim

Resim 1.6: Kenar hatlarına patika çizilmiş resim

Resim 1.7: Dekupe yapılmış resim
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Çizilen bir patikanın şeklini değiştirmek için dolmakalem aracı seçiliyken klavyeden
Ctrl tuşuna basılı tutarak mevcut patika tıklanır, tuşa basılı tutmaya devam edilir.
Dolmakalem biçimli imleç geçici olarak ok biçimini alacaktır. Böylelikle patika üzerinde
mevcut düğüm noktalarını sürükleyerek ve tutamakları hareket ettirerek patikanın biçimi
değiştirilebilir.

Çizimi tamamlanan patikanın şekli otomatik olarak path paletinde yer alacaktır. Path
paletinde bulunan patikaya Ctrl tuşuna basılı tutularak tıklanır ve böylelikle patika seçim
hâline getirilir. Dekupe işlemini tamamlamak için Select/Inverse komutu verilerek patika
dışında kalan bölgeler seçilir. Bu bölge silinerek dekupe işlemi tamamlanır.

1.1.2. Freeform (Serbest El) Pen Aracı

Bir diğer patika çizme yöntemi de serbest el (Freeform) dolmakalem
kullanmaktır. Düğüm noktalarını, doğruları, eğrileri vb. düşünmeden aynı seçme kemendini
kullanır gibi çalışılabilir. Patika hâline getirilmek istenilen bölgede ilk noktaya tıklanır. Daha
sonra aynı kalemle çizgi çizer gibi işaretleme tuşunu (fareyi) basılı tutarak hattın üzerinde
sürüklenir. Patikanın içine doğru hatlar eklemek için klavyeden Alt tuşuna basılı tutarak
işaretleyici bırakılır ve başka bir noktaya tıklanır. İki nokta arasına böylelikle düz bir çizgi
eklenir. Farenin tuşu bırakıldığında patika tamamlanacaktır.

Resim 1.8: Kenarlarına patika çizilen resim

Resim 1.9: Kenarlarına patika çizilmiş resim

Kapalı bir patika çizmek için başlangıç noktasına gelindiğinde, hemen alt tarafta (o)
simgesi belirecektir. Bu simgeyi görünce imleç bırakılır ve kapalı bir patika elde edilir.
Patikanın açık olması istendiğinde istenilen noktada farenin tuşu bırakılır. İlk nokta ile son
varılan noktayı düz bir çizgiyle birleştirmek için Ctrl tuşu ile birlikte ilk noktaya tıklamak
yeterlidir.



8

1.1.3. Düğüm Noktası Ekleme Aracı

Düğüm noktası ekleme (Add Anchor Point) aracı, patikayı daha hassas
biçimlendirmek için mevcut düğüm noktalarının arasına yenilerinin eklenmesini sağlar.

Patika üzerinde düğüm noktası ekleme aracı ile tıklanan her noktaya yeni bir düğüm
noktası eklenir ve yanlarda tutamaklar belirir. İmleç bu tutamakların üzerine getirildiğinde
biçim seçme okuna dönüşür. Bu tutamakları sürükleyerek patika düzenlenebilir. Düğüm
noktalarını artırmak, daha hareketli kavislere sahip patikalar oluşturulmasını sağlar.

Resim 1.10: Path çizilmiş resim Resim 1.11: Daha çok düğüm noktası eklenmiş resim

1.1.4. Düğüm Noktası Silme Aracı

Düğüm noktası silme (Delete Anchor Point) aracı ihtiyaç duyulmayan
düğümleri kaldırmaya yarar. Bu araçla herhangi bir düğüm noktasının üzerine tıklandığında
tıklanan düğüm noktası silinir. Bu işlemi yaparken çok dikkatli olunması gerekir çünkü, her
düğüm noktası eksildiğinde tüm patikanın biçimi etkilenecektir. Düğüm noktası silme
sonrası imleç yine geçici olarak seçme oku biçimini alır ve ister mevcut düğüm
noktalarından ister tutamaklardan yakalayıp sürükleyerek patika eğrisi düzenlenebilir.

1.1.5. Düğüm Noktalarını Dönüştürme Aracı

Düğüm noktalarını dönüştürme (Convert Point) aracı, düğüm noktalarının öz
yapılarını değiştirmeye yarar. Düz patika parçalarının düğüm noktaları ile eğri patika
parçalarının düğüm noktalarının yapıları birbirinden farklıdır. Eğrilere ait olan tutamaklara
sahiptir ve bu sayede biçimleri üzerinde büyük değişiklikler yapılabilir. Kullanım yerine
göre, daha önce oluşturulan düğüm noktalarının yapılarını değiştirmek gerekebilir.
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Bu araçla eğrisel patika parçalarının düğüm noktalarını doğrusal patika parçası düğüm
noktasına dönüştürmek mümkündür. Bu durumda üzerine tıklanan eğri düğüm noktasının
tutamakları kaybolacaktır. İki tutamağı da bu araçla tek tıklanan eğri hat, düğüm noktaları
yerinde kalmak şartıyla doğru hatta dönüşecektir.

Doğru patika parçaları da eğriye dönüştürülebilir. Bu durumda tutamaksız bir düğüm
noktasının üzeri tıklanıp sürüklendiğinde hemen üzerinde tutamaklar belirecektir.

Resim 1.12: Patika çizilmiş resim Resim 1.13: Düğüm noktaları silinmiş ve düzeltilmiş resim

1.1.6. Patika Seçme Araçları

Patika seçim araçları araç kutusunda bulunur ve “A” kısayoluyla veya araç
kutusundan tıklanarak seçili hâle getirilebilir. Path Selection ve Direct Selection olmak üzere
iki farklı patika seçim aracı vardır.

Resim 1.13: Patika seçim araçları

Patikaları Seçme (Path Selection) aracı ekranda üzeri tıklanan bir patikayı seçili hâle
getirerek, resim alanı içinde bir yerden bir yere taşımayı ve üzerinde işlem yapmayı sağlar.
Aynı anda birden çok patikayı seçmek için klavyenin Shift tuşunu basılı tutarak bir diğer
patika tıklanabilir.

Direct Selection (Düğüm Seçme) aracı ise etkinleşen tüm düğüm noktalarını
yerlerinden hareket ettirmeyi ve tutamak noktalarından çekiştirmeyi sağlar. Düğüm seçme
aracı ile düğüm noktası tıklanır ve rengi koyulaşır, farenin işaretleme tuşunu basılı tutarak
istenilen yönde sürüklenir. Sürüklenen yöne doğru patikanın biçimi değişecektir.

Bir eğrinin biçimini değiştirmek sadece düğüm noktaları ve tutamaklarla sınırlı
değildir. Eğrinin üzerinde, düğüm noktaları arasında herhangi bir noktadan tutup
sürükleyerek de benzer işlemler yapılabilir. Bir patikayı seçmek için genellikle üzerine gidip
tıklamak yeterlidir.
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1.1.7. Pen Aracı Seçenekleri Çubuğu

Pen aracı seçenekleri (Pen Options) çubuğu araç seçildiğinde ekranın üst kısmında
belirir. Buradan pen aracının ayarları değiştirilebilir.

Resim 1.14

Dört tarafında düğüm noktası bulunan soldaki ilk düğme işaretlendiğinde patikaların
içine otomatik olarak renk verilecektir. Bu düğmenin hemen sağındaki düğme tıklandığında
ise patikaların içine çizim sırasında herhangi bir dolgu verilmez. Çokgenlerden herhangi biri
seçildiğinde ise seçilen çokgenler çizilebilir.
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UYGULAMA FAALİYETİ

Yukarıda bulunan resim bileşeninin (insanın) kenar hatlarından pen aracıyla geçerek
patika oluşturup, patikayı yeni bir katmana kopyalayınız.

İşlem Basamakları Öneriler

 Resmi inceleyiniz. Hangi patika aracı ile
patika oluşturacağınıza karar veriniz.

 Yukarıdaki resim bileşenin kenarlarına
patika oluşturulmasında en iyi pen aracı
sonuç verir.

 Resim bileşeninin kenar hatlarını pen
aracıyla çiziniz.  Çizim sırasında daha hassas çalışmak

için ekran görünümünü büyütünüz.

 Ayrıntılara dikkat ediniz.

 İlk eklediğiniz düğüm noktasına
tıklayarak patikayı kapalı hâle getiriniz.

 Pen aracı seçenekleri çubuğunda Shape
Layer düğmesi aktif olursa çizdiğiniz
alanın içinde dolgu oluşur. Bunu
engellemek için onun hemen yanındaki
Path düğmesini aktif hâle getiriniz.

UYGULAMA FAALİYETİ
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 Patikayı inceleyiniz. Gerekli düzeltmeleri
tespit ediniz.

 Patikanın resim bileşeninin tam kenar
hatlarını takip edip etmediğine dikkat
ediniz.

 Gerekiyorsa düğüm noktası ekleme aracı
ile düğüm noktası ekleyiniz.

 Araç kutusunda bulunan pen aracına
basılı tutulduğunda ekrana gelen
pencereden düğüm noktası ekleme
aracına ulaşabilirsiniz.

 Düğüm noktası silmek gerekiyorsa siliniz.
 Düğüm noktalarının herhangi birinin

silinmesi tüm patikanın biçimini
etkileyeceğini unutmayınız.

 Düğüm noktası dönüştürme aracı ile
gerekli düzeltmeleri yapınız.

 Doğru patika parçaları eğriye, eğri
patika parçaları doğruya
dönüştürülebilir.

 Düğüm noktası seçme aracı ile gerekli
düzeltmeleri yapınız.

 Düğüm noktası seçme aracı ile düğüm
noktalarının yerlerini değiştirebilir,
böylece kaymaları önleyebilirsiniz.

 Patikayı düzeltme işlemini tamamlayınız.
 Kaymaları, taşmaları düğüm noktası

seçme aracı ile tutamaklardan
oynayarak düzeltebilirsiniz.

 Patikayı resim bileşeninin yan tarafına
taşıyınız.

 Patikayı seçmek için patika seçme
aracını kullanınız. Patika seçme aracına
“A” kısayolu ile ulaşabilirsiniz.

 Birden fazla patikayı seçmek için shift
tuşunu seçim sırasında basılı tutunuz.

 Seçilen patikayı yan tarafa
sürükleyiniz. Shift tuşuna basılı
tutarsanız sağa sola kaydırmadan
taşırsınız.
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 Patikayı hemen yan tarafına kopyalayınız.

 Patika seçme aracı ile patikayı Alt
(Command) tuşuna basılı tutarak seçip
sürükleyiniz. Bu şekilde patikayı
kopyalayabilirsiniz.

 Patikanın Path paletinde aynı Path’e
kopyalandığına dikkat ediniz.

 Patikaları seçim hâline getiriniz.
 Patikaların seçim hâline getirmek için

Ctrl (Komut) tuşuna basılı tutularak
path paletinde bulunan Path’e tıklanır.

 Patikaların içini boyayınız.

 Seçim hâline getirilen patikanın içini
boyamak için Edit>Fill komutu
uygulanır.
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER

Çoktan Seçmeli Test

Aşağıdaki sorularda doğru olan şıkkı işaretleyiniz.

1. Aşağıdaki seçeneklerin hangisinde dekupenin tanımı doğru olarak verilmiştir?
A) Resim üzerinde belirgin olan tram noktacıklarının yok edilmesidir.
B) Resmin büyütme küçütme gibi transform ayarlarının yapılmasıdır.
C) Fotoğrafın belli bir bölgesinin kalan bölgelerden temizlenmesidir.
D) Farklı resim bileşenleri tek bir sayfada birleştirmektir.

2. Aşağıdakilerden hangisi patika oluşturma aracıdır?
A) Magnetic Laso
B) Pen
C) Laso
D) Brush

3. Aşağıdakilerden hangisi serbesteel dolmakalem çizim aracıdır?

A)

B)

C)

D)

4. Aşağıdakilerden hangisinde patikanın tanımı doğru olarak verilmiştir?
A) Magnetic Lasso aracı ile seçilen seçim bölgesidir.
B) Resim bileşeninin temizlenmiş hâlidir.
C) Yeni bir katman oluşturmaktır.
D) Pen (dolmakalem) aracı ile oluşturulan çizimlerdir.

5. Düğüm noktası eklemek için aşağıdakilerden hangisi kullanılır?

A)

B)

C)

D)

ÖLÇME VE DEĞERLENDİRME
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6. Düğüm noktalarını silmek için aşağıdakilerden hangisi kullanılır?

A)

B)

C)

D)

7. Dolmakalem aracı ile oluşturulan çizimler otomatik olarak hangi palette yer alır?
A) Path paleti
B) Layers paleti
C) Kanal paleti
D) Style paleti

8. Patikaları seçmek ve taşımak için aşağıda verilen araçlardan hangisi kullanılır?

A)

B)

C)

D)

9. Düğüm noktalarını dönüştürmek için aşağıda verilen araçlardan hangisi kullanılır?

A)

B)

C)

D)

10. Patikaları kopyalamak için aşağıda verilenlerden hangisi yapılır?
A) Alt tuşuna basılı durumda patika seçim aracı ile patika seçilir ve sürüklenir.
B) Edit>Duplicate komutu verilir.
C) Shift tuşuna basılı tutularak düğüm noktası seçme aracı ile patika taşınır.
D) Layer>New>Layer Via Copy komutu verilir.
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DEĞERLENDİRME

Cevaplarınızı modül sonundaki cevap anahtarı ile karşılaştırınız ve doğru cevap
sayınızı belirleyerek kendinizi değerlendiriniz.

Ölçme sorularındaki yanlış cevaplarınızı tekrar ederek, araştırarak ya da
öğretmeninizden yardım alarak tamamlayınız.
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B. UYGULAMALI TEST

Öğrenme faaliyetinde kazandığınız becerileri aşağıdaki kontrol listesine göre
değerlendiriniz.

İşlem
Nu

Değerlendirme Ölçütleri Evet Hayır

1 Hangi patika aracının kullanılacağını bulabildiniz mi?

2
Resim bileşeninin kenar hatlarından patika
oluşturabildiniz mi?

3 Patika üzerinde gerekli düzeltmeleri tespit edebildiniz mi?

4 Patikaya düğüm noktası ekleyebildiniz mi?

5 Patikadan düğüm noktası silebildiniz mi?

6 Düğüm noktalarını dönüştürebildiniz mi?

7
Düğüm noktası seçim aracı ile gerekli düzeltmeleri
yapabildiniz mi?

8 Patika düzeltme işlemlerini tamamlayabildiniz mi?

9 Patikayı taşıyabildiniz mi?

10 Patikayı kopyalayabildiniz mi?

11 Patikaları seçime dönüştürebildiniz mi?

12 Patikaların içine renk verebildiniz mi?

Faaliyet değerlendirmeniz sonucunda “hayır” işaretleyerek yapamadığınız işlemleri
tekrar ediniz.

Tüm işlemleri başarıyla tamamladıysanız bir sonraki faaliyete geçiniz.
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ÖĞRENME FAALİYETİ–2

Bu faaliyet ile gerekli ekipman sağlandığında, resmi path (yol, patika) hâline
getirebilecek ve dekupe işleminde kullanılan diğer yöntemleri kullanarak dekupe
yapabileceksiniz.

 Basılı ve elektronik yayınları inceleyiniz. Özellikle masaüstü yayıncılık
dergilerinden dekupe örneklerine ve ayrıntılı bilgilere ulaşabilirsiniz.
Profesyonel fotoğrafçıların dekupe işlemini nasıl yaptığını araştırınız.
Çevrenizdeki bu konuda uzman kişilerden bilgi alınız. Topladığınız bilgileri
arkadaşlarınızla paylaşınız.

2. DEKUPE İŞLEMİNDE KULLANILAN
PALET VE FİLTRELER

Resim işleme programında dekupe yapmanın birden çok yöntemi vardır. Pen aracıyla
oluşturulan patikalar kullanılarak dekupe yapılabileceği gibi özel filtreler kullanılarak da
dekupe yapılabilir.

2.1. Path (Patika) Paleti

Patikaların kontrolü ve düzenlenmesi Path paleti ile yapılır. Pen aracı ile çizilen patika
Path paletinde otomatik olarak yer alır ve o an için yanında “Work Path” yazar. Bu yeni bir
patika sayfasıdır. Yazının sol tarafında ise çizilmiş patikanın küçük bir görünümü yer alır.
Ona bakarak listede hangi patika ile çalışıldığı kontrol edilir.

Resim 2.1: Resim üzerinde çizilmiş patika ve Path paleti

ÖĞRENME FAALİYETİ– 2

AMAÇ

ARAŞTIRMA
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2.1.1. Patika Paleti Seçenekleri

2.2.1.1. Patikaları Kaydetmek (Save Path)

Listedeki patika adının üzeri çift tıklanarak veya paletin sağ üst tarafındaki ok (palet
menüsü) tıklanarak, ekrana gelen listeden “Save Path” komutu verilip patika yeni bir isimle
kaydedilebilir.

Resim 2.2: Çizilen patikanın kaydedilmesi

2.2.1.2. Yeni Patika Oluşturmak (New Path)

Kaydedilen patikanın dışında yeni bir patika eklemek için palet menüsünden “New
Path” komutu verilir. Herhangi bir patika sayfası seçili olmadığında çizilen patikalar
otomatik olarak yeni bir patika sayfasında yer alır. Patika sayfası seçili olduğunda ise çizilen
patikalar seçili patika sayfasında yer alacaktır.

Resim 2.3: Resim ve Path paleti

Sonsuz sayıda patika oluşturulabilir. Oluşturulan her patikayı ayrı bir isimle
saklamakta fayda vardır. Palette görünen patikalardan hangisinin üzeri tıklanırsa o etkin hâle
gelecektir. Ayrıca herhangi bir patika çift tıklanarak ekrana gelen kutudan patikaya yeni bir
isim atanabilir.
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Patika sayfasının bir kopyasını listeye eklemek için, palet menüsündeki “Duplicate
Path” komutu kullanılabilir. Bu komut verildiğinde ekrana gelen diyalog kutusundan yeni bir
isim verilerek çoğaltma işlemi tamamlanır.

Ekranda aynı zamanda sadece Paths paletinde seçili olan patika görünür. Diğerleri
gizlenir. Tüm patikaları gizlemek için palet listesi içinde patika isimlerinin dışında kalan gri
boşluğa tıklanır.

2.2.1.3. Patika Sınırlarının İçini Doldurmak (Fill Path)

Patikaların içini ön plan rengiyle boyamak için patika seçiliyken, patika paletinde yer
alan Fill Path simgesi tıklanır.

Resim 2.4: Path paleti

Palet menüsünden açılan Fill Path komutu da patikanın içini renkle doldurmaya yarar
ve buradan Fill Path seçeneklerine ulaşılabilir. Örneğin patika ön plan rengiyle değil de
dokuyla doldurulacağı zaman palet menüsündeki Fill Path komutu kullanılır. Patika sayfası
içinde yalnızca bir adet kapalı patika boyayla doldurulmak istendiğinde, o patikanın
çiziminin yeni bitmiş veya sonradan seçilmiş olması gerekir. Aksi takdirde doldurma işlemi
o patika sayfasının tümüne uygulanır.

Resim 2.5: Coçuk path sayfasına fill path komutu verilen resim
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2.2.1.4. Patika Hattını Boyamak (Stroke Path)

Path paletinde yer alan Stroke Path simgesi, bir patika sayfası içinde oluşturulan tüm
açık veya kapalı patikaların sınırlarını ön plan rengiyle doldurur. Yani Stroke path komutu
ile patikalar çizgiye çevrilir. Bu simge her tıklandığında, patika hattını boyama işlemi bir kez
daha uygulanacaktır. Resim işleme programında hassas çizgi çizmenin en kolay yolu budur.
Hat belirlenir, hat üzerinde gerekli değişiklikler yapılır ve çizgiye çevrilir. Patika hattı
üzerinde çizilen renkli sınır patikayı değil, resmi boyar ve kalıcıdır.

Palet menüsünden Stroke path komutu verildiğinde ekrana Stroke Path diyalog kutusu
gelir.

Resim 2.6: Stroke path diyalog kutusu ve stroke path uygulanmış resim
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Stroke Path penceresinde yer alan seçeneklerin yardımıyla patika daha hassas biçimde
farklı bir görüntüden oluşan çizgiye dönüştürülebilir. Bu pencerede yer alan Tool açılan liste
kutusundaki çizgi çizme seçeneklerinden herhangi birisi seçilebilir. Bu seçenekleri tek tek
deneyerek resimde nasıl bir etki oluşturduğunu görebilirsiniz.

Yukarıda verilen resimde topun bulunduğu path sayfası seçili iken palet menüsünden
Stroke Path komutu verildi. Ekrana gelen diyalog kutusundan Brush seçeneği işaretlendi ve
işlem onaylanarak top patikasınan kenarları yukarıdaki şekli aldı.

Stroke Path penceresinde seçilecek aracın etkisini, onun için yapılan Brush (fırça tipi)
ve Options (Seçenekler) ayarları belirleyecektir.

2.2.1.5. Patikayı Seçim Setine Dönüştürmek (Make Selection)

Path paletinin alt tarafında yer alan Make Selection düğmesi ve palet menüsünde yer
alan Make Selection komutu, seçili olan patikanın çevrelediği alanı seçim seti hâline getirir.
Şayet patika çokgeni kapalı değilse başlangıç ve bitiş uçlarının arasını düz bir hatla doldurup
kapatılır ve bu şekilde seçili hâle getirilir. Özellikle Lasso ve diğer seçim araçlarıyla
seçilmesi zor alanlarda daha iyi sonuç verir.

Palet menüsünden Make Selection komutu verildiğinde Make Selection diyalog
kutusu açılır. Paletin alt tarafında bulunan Make Selection düğmesi tıklandığında bu pencere
ekrana gelmeyecek ve işlem direkt yapılacaktır.

Ekrana gelen Make Selection diyalog kutusunda iki bölge vardır.

Resim 2.7: Make selection diyalog kutusu

Rendering: Oluşturulacak seçme çokgeninin özgün özelliklerini ayarlar. Piksel
cinsinden köşe yuvarlama yarıçapı ölçüsü Feather Radius metin kutusuna yazılır. Yumuşak
bir geçiş için Anti-aliased onay kutucuğu işaretlenir.
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Operation: Patikadan dönüştürülecek seçme alanının nasıl davranacağını ayarlamak
için bulunan seçeneklerdir.

New Selection: Tümüyle yeni bir seçme alanı olarak
Add to Selection: Önceden seçili bir alana ek olarak
Subract From Selection : Önceden seçili bir alandan eksiltme olarak
Intersect With Selection: Önceden seçili bir alan ile kesiştirme olarak

Patika sayfası içinde yalnızca bir adet patika seçim setine dönüştürmek isteniyorsa, o
patikanın çiziminin yeni bitmiş veya sonradan çizilmiş olması gerekir. Aksi takdirde patika
sayfasındaki tüm patikalar seçim seti olur ve bu her zaman istenmeyebilir.

2.2.1.6. Seçim Setini Patikaya Dönüştürmek (Make Work Path)

Path paletinin alt tarafında yer alan Make Work Path From Selection simgesi, resim
üzerinde seçim araçları kullanarak çevrelenen bir veya daha çok alanı patika hâline getirir.
Gayet yararlı bir araçtır; çünkü bazen de patika çizmek zordur ve seçim araçlarının bazı
kolaylıklarından yararlanmak gerekebilir; örneğin sihirli değnek gibi…

Resim 2.8: Seçim halinde olan resim Resim 2.9: Patikaya dönüştürülmüş resim

Resim 2.10: Make Work Path diyalo kutusu

Ekrandaki seçim setini patikaya dönüştürmenin bir diğer yolu da palet menüsünden
Make Work Path komutunu vermektir. Bu durumda, düğmede olduğundan farklı olarak
Make Work Path mini diyalog kutusu ekrana gelecektir.
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Tolerance değeri piksel cinsinden metin kutusuna yazılır. Tolerans ya da buradaki
anlamıyla hassasiyet değeri 0,5 ile 10 piksel arasında değişir ve seçili alanın çevresinde
oluşacak patikanın bu alanı ne kadar hassas olarak saracağını belirler. Burada hassasiyeti
saptayan, düğüm noktalarının sıklığı olacaktır. Büyük Tolerance değeri, az sayıda düğüm
noktasına karşılık gelir.

2.2.1.7. Kırpma Patikası Oluşturmak (Clipping Path)

Dolmakalem aracı ile çizilen ve resim dosyasıyla birlikte EPS dosya formatında
kaydedilen patikaların içinde kalan piksel tabanlı nesneler, çeşitli illüstrasyon veya sayfa
mizanpaj programlarında zeminsiz (kenarları boş) olarak kullanılabilir. Bunlara saydam
fonlu resimler de denir.

Görüntüyü kırpmak için yeni bir patika sayfası oluşturulur ve ihraç edilecek nesne
resim penceresinde patika ile çevrelenir (Patika çizilir). Ardından Path paleti menüsünden
kırpma komutu (Clipping Path) verilir. Ekrana Clipping Path diyalog kutusu açılır.

Resim 2.11: Clipping path diyalog kutusu

Path: Açılan listenin içinden, kırpmada kullanılacak patikanın adı seçilir. Bunlar
çizimde daha önceden oluşturulan patikalardır.

Flatness: Metin kutusuna piksel cinsinden ithal edilecek resmin kalitesine ilişkin bir
değer girilir. “0,2 ile 100” arasında değişen bu değere resmin gerginlik değeri de denilebilir,
çünkü Flatness değeri, kırpma patikasını oluşturan segmanların, nesnenin sınırını
oluştururken ne oranda kavisleneceğini belirler. Değer yükseldikçe gerginlik artacak ve dış
sınırı oluşturan segmanlar o oranda düz çizgilere dönüşecektir. Oysa düşük değerlerde daha
gevşek duracak ve sınırı daha kolaylıkla saracaktır. 300 veya 600 dpi gibi düşük
çözünürlüklerde 1 ila 3 arası yeterli olacaktır. 1200 veya 1400 dpi gibi yüksek
çözünürlüklerde ise 8 ila 10 arası bir gerginlik değeri yeterli olacaktır.

Resim 2.12: Kırpılmış resim
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Bu ayarlar yapıldıktan sonra dosya TIFF veya EPS formatında kaydedilir. En iyi
zeminsiz sonuç EPS ve TIFF formatıyla elde edilebilir. Hangi formatta zeminsiz transfer
edileceği sisteme ve aktarılacak programa göre değişebilmektedir.

2.2. Dekupede Kullanılan Filtreler

2.2.1. Filter / Extract

Dekupe, pen aracı ve path paleti kullanılmadan Filter > Extract komutu ile yapılabilir.
Diğer yöntem ve araçlar özelliklerini korusa da Extract filtresi ile dekupe hızlı bir şekilde
yapılabilmektedir. Kırılgan ve geçici seçim araçlarının yerine, üzerinde piksel piksel
çalışılabilir. Dekupe edilecek alan bir nevi kalemle çizer gibi belirlenir.

Filter Extract (Alt + Ctrl + X; Option + Command + X) komutu verildiğinde Extract
diyalog kutusu açılır. Açılan diyalog kutusunda dekupe edilecek resim yer alır.

Resim 2.13: Extract penceresi

Extract penceresinin sol üst köşesinde minik bir araç kutusu bulunur. Bu araçlarla
dekupe edilecek alan işaretlenir. En üstte yer alan araç işaretleyicisi (Edge Highlighter,
Seçme fırçası) aracı kullanılarak, resmin üzerinde dekupe edilecek alan çevrelenir.
Değiştirilmediği müddetçe Seçme Fırçası ile yapılan çizimler fosforlu yeşil olacaktır.
Kalemle ya da fırçayla çizer gibi çevresindeki sınır çizilir. Hata yapıldığında çizimin
tamamını veya bir kısmını silmek için mini araç kutusunda silgi de bulunur. Ayrıca el aracı
ile resim kaydırılarak ve büyüteç aracı ile büyütülerek daha hassas ve rahat bir şekilde
çalışılabilir.



26

Sınırları seçme fırçası ile belirlenmiş alanın içi mini araç kutusunda yer alan boya
kovası ile doldurulur. Değiştirilmediyse dolgu rengi mavi olacaktır. Smart Highlighting
seçeneği ile seçme hattının resimdeki kontrast farklarına duyarlı olması sağlanabilir.

Seçme fırçasının kalınlığı, hassas sınır çizme açısından önemlidir. Bunu Extract
penceresinin sağ kısmında bulunan Tool Options bölgesindeki Brush Size metin kutusunda
piksel cinsinden belirlenebilir. Highlight metin kutusu ise seçim fırçasının renginin
belirlenmesini sağlar. Sınırların içine boya dökülür. Bu boyanın rengi de Fill metin
kutusundaki seçenekler kullanılarak belirlenebilir.

Resim 2.13: Extract penceresi

Tool Options bölümünün alt tarafında yer alan Extraction bölgesinde Smooth ayarı
ile seçili alanın sınırları yumuşatılabilir ve olası minik sınır belirleme hataları kapatılabilir.
Bu ayarlar yapıldığında ve sınırlandırılmış alanın içine boya döküldüğünde, yukarıdaki
Preview düğmesi etkin hâle gelecektir. Bu düğmeye tıklandığında dekupe etme amacıyla
sınırları çizilen alan görülür. Preview bölgesinde önemli ön izleme seçenekleri yer
almaktadır.

View: Bu liste kutusu sayesinde orijinal resim ile dekupe edilmiş hâli arasında geçiş
yapılabilir.



27

Show: Buradan dekupe edilen alanın nasıl bir zemin içinde gösterileceği ayarlanır.
Gri, siyah, beyaz ve none (saydam) tercih edilebilir. Other seçeneği ile Color Picker’a
ulaşılarak yeni bir zemin seçilebilir.

Show Highlight: Sınır çizme kaleminin izini gizler veya gösterir.

Show Fill: Sınır içi dolgusunu gizler veya gösterir.

Sonuç istenilen şekilde ise OK düğmesi tıklanarak dekupe işlemi tamamlanır.

Resim 2.14: Dekupe edilmiş resim
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UYGULAMA FAALİYETİ

Yukarıdaki resmi pen aracını ve path paletini kullanarak dekupe ediniz ve sayfa
mizanpaj programlarına zeminsiz (kenarları boş) aktarılacak şekilde hazırlayınız.

İşlem Basamakları Öneriler

 Dolmakalem aracı ile dekupe edeceğiniz
alanı çevreleyiniz.

 Dolmakalem aracını “P” kısa yolu
ile seçebilirsiniz.

 Büyüteç aracı ile resmin
görünümünü büyüterek çalışınız.

 Eklenen düğüm noktalarında
yönlendirme çizgilerini kullanarak
daha hassas çizim yapabilirsiniz.

 Çizilen patikayı inceleyiniz. Diğer patika
araçlarını kullanarak patikayı düzeltiniz.

 Convert Point aracı ile düğüm
noktalarını dönüştürebilirsiniz.

 Patikayı seçim hâline getiriniz.
 Path paleti menüsünden Make

Selection komutu ile patika seçili
duruma getirilebilir.

 Seçili bölgenin dışında kalan bölgeyi
seçip siliniz.

 Seçimin tam tersini seçmek için
Select / Inverse komutunu
kullanabilirsiniz.

 Dekupe hattının kenarlarını
yumuşatmak için silmeden önce
Select>Feather komutu ile
yumuşatma değeri veriniz.

UYGULAMA FAALİYETİ
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 Patikanın bulunduğu path sayfasını
kaydediniz.

 Patikayı path paleti menüsünden Save
Path komutu ile kaydedebilirsiniz.

 Kaydedilen patikayı illüstrasyon
programlarına zeminsiz aktarabilmek için
kırpma patikası hâline getiriniz.

 Patikayı kırpma patikası hâline
getirmek için path paleti menüsünden
Clipping Path komutunu veriniz.

 Resmi Tiff formatında kaydediniz.
 Resmin aktarılacağı programa göre

dosya formatı olarak Eps veya Tiff
formatı seçilir.
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER

Çoktan Seçmeli Test

Aşağıdaki sorularda doğru olan şıkkı işaretleyiniz.

1. Aşağıdaki seçeneklerin hangisinde patikaların düzenlendiği ve kontrol edildiği palet
verilmiştir?
A) Layers
B) Channels
C) Path
D) History

2. Dekupe çalışmaları için kullanılan filtre aşağıdakilerden hangisinde doğru olarak
verilmiştir?
A) Extract
B) Liquify
C) Twirl
D) Sharpen

3. Kırpma patikası oluşturmak için kullanılan ve path paleti menüsünde yer alan komut
aşağıdakilerden hangisidir?
A) Make Selection
B) Stroke Path
C) Make Work Path
D) Clipping Path

4. Seçim bölgesini patikaya dönüştürmek için kullanılan ve path paleti menüsünde yer
alan komut aşağıdakilerden hangisidir?
A) Make Selection
B) Stroke Path
C) Make Work Path
D) Clipping Path

5. Patikayı seçim setine dönüştürmek için kullanılan komut aşağıdakilerden hangisidir?
A) Make Selection
B) Stroke Path
C) Make Work Path
D) Clipping Path

ÖLÇME VE DEĞERLENDİRME
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6. Patika hattını boyamak için kullanılan ve path paleti menüsünde yer alan komut
aşağıdakilerden hangisidir?
A) Fill Path
B) Stroke Path
C) Make Work Path
D) Clipping Path

7. Patika sınırlarının içini doldurmak için kullanılan ve path paletinde yer alan komut
aşağıdakilerden hangisidir?

A) Stroke Path
B) Clipping Path
C) New Path
D) Fill Path

8. Yeni bir patika sayfası oluşturmak için kullanılan ve path paletinde yer alan komut
aşağıdakilerden hangisidir?
A) Stroke Path
B) Clipping Path
C) New Path
D) Fill Path

DEĞERLENDİRME

Cevaplarınızı modül sonundaki cevap anahtarı ile karşılaştırınız ve doğru cevap
sayınızı belirleyerek kendinizi değerlendiriniz.

Ölçme sorularındaki yanlış cevaplarınızı tekrar ederek, araştırarak ya da
öğretmeninizden yardım alarak tamamlayınız.
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B. UYGULAMALI TEST

Öğrenme faaliyetinde kazandığınız becerileri aşağıdaki Kontrol listesine göre
değerlendiriniz.

İşlem
NU

Değerlendirme Ölçütleri Evet Hayır

1
Dolmakalem aracı ile dekupe edeceğiniz alanı
çevreleyebildiniz mi?

2
Diğer patika araçlarını kullanarak çizimin eksik veya
yanlış olan yerlerini düzeltebildiniz mi?

3 Patikayı seçim hâline getirebildiniz mi?

4 Seçimin tersini alıp seçimi silebildiniz mi?

5 Path’i kaydedebildiniz mi?

6 Patikayı kırpma patikası yapabildiniz mi?

7
Resmi TIFF veya EPS formatında kaydederek zeminsiz
olarak aktarabildiniz mi?

Faaliyet değerlendirmeniz sonucunda “hayır”ı işaretleyerek yapamadığınız işlemleri
tekrar ediniz.

Tüm işlemleri başarıyla tamamladıysanız bir sonraki faaliyete geçiniz.
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MODÜL DEĞERLENDİRME
UYGULAMALI TEST (YETERLİLİK ÖLÇME)

Uygun bir orijinalin dekupe işlemini yapınız.

Modülde kazandığınız becerileri aşağıdaki tablo doğrultusunda ölçünüz.

İşlem
No

Değerlendirme Ölçütleri Evet Hayır

1 Hangi patika aracının kullanılacağını bulabildiniz mi?

2
Resim bileşeninin kenar hatlarından patika oluşturabildiniz
mi?

3 Patika üzerinde gerekli düzeltmeleri tespit edebildiniz mi?

4 Patikaya düğüm noktası ekleyebildiniz mi?

5 Patikadan düğüm noktası silebildiniz mi?

6 Düğüm noktalarını dönüştürebildiniz mi?

7
Düğüm noktası seçim aracı ile gerekli düzeltmeleri
yapabildiniz mi?

8 Patika düzeltme işlemlerini tamamlayabildiniz mi?

9 Patikayı taşıyabildiniz mi?

10 Patikayı kopyalayabildiniz mi?

11 Patikaları seçime dönüştürebildiniz mi?

12 Patikaların içine renk verebildiniz mi?

13 Seçimin tersini alıp seçimi silebildiniz mi?

14 Path’i kaydedebildiniz mi?

15 Patikayı kırpma patikası yapabildiniz mi?

16
Resmi TIFF veya EPS formatında kaydederek zeminsiz
olarak aktarabildiniz mi?

DEĞERLENDİRME

Modül değerlendirmeniz sonucunda hayırı işaretlediğiniz işlemleri tekrar ediniz. Tüm
işlemleri başarıyla tamamladıysanız modülü başardınız. Tebrikler. Başka bir modüle
geçebilirsiniz.

MODÜL DEĞERLENDİRME
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CEVAP ANAHTARLARI

ÖĞRENME FAALİYETİ 1 CEVAP ANAHTARI

1 C
2 B
3 A

4 D

5 B

6 D

7 A

8 C

9 B

10 A

ÖĞRENME FAALİYETİ 2 CEVAP ANAHTARI

1 C
2 A
3 D

4 C

5 A

6 B

7 D

8 C

CEVAP ANAHTARLARI
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